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3.	Fundamental	concepts	
The TiF454 software can create and edit a project containing the device 
configuration to manage My Home systems remotely.
The created project must be sent (Send the configuration) to the device. 
In the same way it will be possible to receive the project file (Receive the 
configuration) from the device, to check or edit the configuration contained.
The TiF454 can also be used to update the permanent base software of the device 
(firmware) by downloading the new versions distributed by BTicino.

To	create	a	new	project
	• Run TiF454.
	• Make a new project.
	• Send the data to the device.

To	edit	an	existing	project
	• Receive the current configuration data from the device.
	• Make any modifications.
	• Send the data of the project created to the device.

1.	Hardware	and	Software	requirements	
System	requirement*
	• PC with Pentium > 2 GHz
	• CD-ROM unit
	• Video resolution 800 x 600, 256 colours
	• Windows XP SP2 (32 bit), Windows Vista (32 bit or 64 bit) or Windows 7 (32 bit 
or 64 bit)
	• 1 GB RAM memory (XP)
	• Hard Disk: 500 MB minimum free space available
	• Framework .NET 3.5 SP1 of Microsoft™
	• Minimum browser requirements for correct display of the web pages: Internet 
Explorer ver. 7, Firefox ver. 3, Chrome ver. 9, Safari ver. 4.    
However, for the energy supervision function higher Internet Explorer 
requirements are necessary: ver.8 + Google Frame plug-in or better.

*The updated requirements can be found on the www.bticino.com website

Warning: The TiF454 software is the fundamental tool for the configuration of the F454 
Web Server, which, for convenience, will be referred to as device in this manual. 
This software is protected by exclusive rights, owned by the company BTicino SpA

2.	Software	update	
Once installed, the TiF454 software will automatically search for any updated ver-
sions on line.
If any are found, the user will be asked to enter a path for saving the new updated 
version executable file: 

It will however still be possible to work using the current version and install the 
update at a later date.
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On opening the program, the start screen is displayed, which contains all the 
configuration parameters. The Screen essentially consists of 3 sections: the left 
sections	(A) lists all the parameters and functions that need to be configured in a 
tree menu. Based on the selection made by the user, the central section (B) will 
show the data fields to be selected or entered. The bottom section (C) displays 
any error configurations in red. These can be clicked to display which functions 
have been configured wrongly. 

3.1	Function	selection	menus	and	pushbuttons

1.	Pull-down menus

2.	Pushbutton menu

3.	Function description

4.	Closes the Info and Errors area

5.	Navigation bar

6.	Info and Errors area

7.	Opens the Info and Errors area 

With TiF454 you can update the device firmware version (“Update the Firmware”) 
with new revisions issued by BTicino.

Attention: for the TiF454 software to work correctly, the device must be installed in 
agreement with the indications given in the instruction sheet supplied with the device.
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To receive/send the configuration completed using the TiF454 software, or to update 
the firmware, connect the device to the PC using a USB/miniUSB cable, the serial-
USB adapter (3559), or an Ethernet cable.

3.2	Connecting	the	device	to	a	PC

SCS AI SCS AV

ETHERNET

USB	connection

Ethernet	connection

(*) Crossover cable for direct connection. 

*

SCS AI SCS AV

ETHERNET
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It allows the user to send the project created to the device.

Procedure:
1.	Connect the device to a PC as shown in the corresponding section.
2.	From the Tools pull-down menu select Send Configuration.

The following window appears:

3.3	Send	the	configuration

3.	Click Next to display the window for the selection of the mode of connection 
with the device. The sending operation can be performed using two different 
types of connection:

	• Ethernet: by entering the network address, or by automatic search;
	• USB: through automatic detection of the connected items.

4.	Select the mode.
5.	Click Next.
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USB	CONNECTION

ETHERNET	CONNECTION

6.	Enter the network address and the OPEN password.
7.	Click Next.

6.	Wait for the device to be recognised automatically. 
7.	Click Next.

6
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The project is transferred to the device.

A) Display the details of the current configuration forwarding operation
B) Hide the details of the current configuration forwarding operation
C) Export the log file
D) Repeat the operation if unsuccessful

It allows the user to receive the configuration from the device; once the 
configuration has been acquired, this can be changed and saved, or it can be 
resent to the device.

Procedure:
1.	Connect the device to a PC as shown in the corresponding section.
2.	From the Tools pull-down menu select Receive	Configuration.

A mask is displayed, for the selection of the mode of connection to the device 
(for the connection procedures see the Send	the	Configuration section).

After selecting the connection mode, Click Next to load the project currently 
installed on the device.

3.4	Receive	the	configuration
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3.5	Update	the	Firmware
It allows the user to update the device firmware.

Procedure:
1.	Connect the device to a PC as shown in the corresponding section.
2.	From the Tools pull-down menu select Update	Firmware.

3.6	Request	device	info
It displays some information on the device connected to the PC.

Procedure:
1.	Connect the device to a PC as shown in the corresponding section.
2.	From the Tools pull-down menu select Request	Device	Info.

This action will open a mask for the selection of the mode of connection to 
the device (for the connection procedures see the Send	 the	 Configuration 
section).
After selecting the connection mode, Click Next to display a screen showing the 
device hardware and software features.

The following screen appears, prompting the user to search for the folder containing 
the firmware file with extension .fwz (compressed file).

3.	Click Find. 
Select the file and click Open to continue.

This action will open a mask for the selection of the mode of connection to 
the device (for the connection procedures see the Send	 the	 Configuration 
section).
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4.	Project	configuration	
This section can be used to configure a new project, or to change an existing one.

1.	From the File menu select New. The following window appears:

2.	Enter the configuration data in the various zones.

4.1	Network	connections
The technical parameters for the network connections are configured in this section.

4.1.1	Ethernet
This screen can be used to enter the parameters for connection to the Ethernet 
network.

Before editing the default values, contact the network administrator.
as well as making the service inactive, incorrect values could cause malfunctions in the 
communication of other network equipment.
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Configuration:
	• UPnP	IGD
Enable the function for direct connection of the device without any need for 
configuring your own router (check that the router supports this functionality).
	• Addressing	type
Select if the address is a fixed (in which case the parameters below must be 
entered), or a dynamic DHCP type address. 
	• Web	server	IP	and	Subnet	mask
Enter the typical parameters of TCP/IP protocol networks required for identifying 
the device within the local network. Remember that the device needs a “static” 
(fixed and unique) IP address to be able to work correctly.
	• Router	IP
Enter the IP address of the router, if any. If there is a router the field must be 
filled in, to ensure the outgoing Services, such as sending e-mails. 
	• Primary	DNS	and	Secondary	DNS
Enter primary and secondary IP address of the Internet Service Provider (ISP) 
supplied at the time of subscription
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4.2	General	parameters
This section is used for the configuration of the General device parameters. 

4.2.1	Clock
This screen is used to enter the parameters for managing the time the device and 
the system will refer to (Master function active).

Configuration:
	• Time	zone
Enter the local time zone.
	• Update	function
Define if the device is a system time synchronisation “Master”, in which case the 
internal clock of the device will be used as time reference by other devices of 
the My Home system. 
	• Update	frequency
If the clock is set as Master, set  the time update frequency for all the devices.
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4.2.2	Univocal	codes
This screen is used to configure the gateway ID.

Configuration:
	• OPEN‑SCS	Gateway
Enter a unique ID number for the OPEN-SCS gateway function. 
	• 2	WIRE	AV	Web	Server
Enter a unique ID number for the Web Server function. 

4.2.3	Handset	address
This screen can be used to enter the address of the Handset to associate to the 
Web Server.

Configuration:
	• Handset	address
Enter the handset address. The field can accept values between 0 and 99.
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4.3	Security
This section is used to set the safety parameters.

4.3.1	Authentication
This window can be used to set the Login and the Password for access to the Web 
pages and to other Services. 

4.2.4	Language
This window can be used to select the language for the control web pages and 
remote system management.

Configuration:
	• Language
Select the language that will be used to display the Web pages. 
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4.3.2	Web	session
This window can be use to set the length of time the web page will remain inactive 
before the device returns the user to the identification page. 

Configuration:
	• Web	session	timeout
Select the duration of the session, either 1, 2, 5, or 15 minutes. 

Configuration:	
Web	users	
	• User	Login	and	User	password
Enter the Login and the Password for access to the Web pages in user mode  
(default: user.user).
	• Administrator	login	and	Administrator	password
Enter the Login and the Password for access to the Web pages in administrator 
mode (default: admin.admin), this mode is used to enable the configuration 
pages. 

Safe	cameras
	• Enabling
Enable and enter a password to display the images sent by the cameras in safe 
mode.

Attention: The default OPEN password in the devices is 12345.

Automatic	system
	• OPEN	Password
Enter the OPEN password for the device.
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3

4.3.3	IP	address	enabling
This window can be used to enter up to 10 IP address ranges with connection to 
the device enabled, without the need for entering the OPEN password.

Procedure:
1.	Enable the interval of IP addresses. 
2.	Click.

3.	Enter the range of network addresses. 
4.	Confirm.
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Remote	access
This window can be used, if required, to disable remote connection to the device. 
This is done by setting the auxiliary channel from which the command is received. 

4.3.4	Remote	commands
This window can be used to set the parameters for adjusting the remote access. 

Configuration:

Signalling	actuator
	• Enabling
Enable a light point to use as signalling actuator for the activation/deactivation of 
the remote access.
The activation status may be indicated by a notification light coming on, controlled by 
an actuator of the Automation system.
	• Actuator	address
Enter the SCS address of the notification actuator (see “Common Configurations” ).

Activation/deactivation	event
	• Enabling
Enable the possibility of activating/deactivating remote access to the Web Server 
using an auxiliary channel. 
	• Remote	access	channel
Enter the activation/deactivation auxiliary channel.
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OPEN	commands		to	be	blocked
This window can be used to block the forwarding of certain commands received by 
the device. 
The definition of the forbidden commands (max. 20) is performed by entering 
them in the appropriate area, following the “Open Web Net” protocol.

	– Manual

Procedure:
1.	Click to insert the command. it is possible to choose one of the following two 

modes:

2. Click for manual insertion. 3. Insert the OPEN command to block 
directly. 

3
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	– Using	the	wizard

				

2. Click for the insertion wizard. 3. Automatically define the command 
to block by selecting in the appropriate 
screen: the system (Scenarios, Lights or 
Automation), the action (which changes 
depending on the system) and the SCS 
address (see “Common Configurations” ).

4.	Click OK.

It is also possible to modify the command	 (A), remove it (B), or remove all 
commands (C).

3
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4.4	Services
The web pages of the My Home applications are configured in this section.

4.4.1	Web	pages
This window can be used to create and modify the Web pages for the definition 
of the objects for the activation of the functions corresponding to the My Home 
applications within the system.



22

Before adding an object, a page must be added.
After adding an object, a window appears where the user can enter the specific data. 

	– Entering	the	SCS	address

3

1
2

1.	Enter the value of room configurator A (0 - 10; GEN, ROOM, GR).
2.	Enter the value of the configurator of the PL light point (the number depends 

on the function).
3.	Select if the level is a private Riser or a local bus. In the second case also enter 

the values I3 and I4.

1 6

2 74 93 85

1.	Object	management
2.	Add an object
3.	Delete an object
4.	Delete all objects
5.	Move objects

6.	Page	management
7.	Add a page
8.	Delete a page
9.	Rename a page

Click this key to assign a description 
to the web page (15 characters max.).

   

Common	configurations
This section explains the configurations found in all the configuration screens of 
the Web pages. 

	– Adding	objects/pages
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Configuration:
	• Description
Enter the description of the object (15 characters max.).
	• Type
Select if the scenario is a Normal or a Plus scenario.
	• Address
1.	Click to select the address of the scenario to perform, saved in a scenario module.

This window can be used to define the objects found in the “Scenarios” web page, 
where it is possible to activate the scenarios managed by the control unit, or by 
the scenario module installed in the system.
It is possible to configure up to 9 Web pages with 10 objects each, one of which 
at least correctly configured.
Add the pages/objects (see “Common Configurations” ).

2.	Select the scenario.
3.	Click to enter the SCS address of the scenario module (see “Common Configurations” ).

Scenarios

1
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This window can be used to define the objects found in the “Lighting” web page, 
where it is possible to control the lights of the system. 
It is possible to configure up to 9 Web pages with 10 objects each.
Add the pages/objects (see “Common Configurations” ).

Configuration:
	• Description
Enter the description of the object (15 characters max.).
	• Address
Enter the SCS address of the actuator (see “Common Configurations” ).
	• PUL
Set to “Yes” if the corresponding actuator is in PUL mode. 
	• Dimmer
Set the type of Dimmer, 10/100 levels (if enabled).
	• Timing
Set the time delay in case of delayed switching on (from 30 sec. to 15 minutes).
	• Blinking
Set the frequency in case of flashing switching on (from 0.5 sec. to 3.5 sec).

Lights
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Configuration:
	• Description
Enter the description of the object (15 characters max.).
	• Address
Enter the SCS address of the actuator (see “Common Configurations” ).
	• PUL
Set to “Yes” if the corresponding actuator is in PUL mode. 

This window can be used to define the objects found in the “Automation” web page, 
where it is possible to control the shutters/curtains of the system.  
It is possible to configure up to 10 Web pages with 10 objects each.
Add the pages/objects (see “Common Configurations” ).

Automation

This window can be used to define the objects found in the “Load Control” web page, 
where it is possible to display the status of a load and force its reactivation.  Add the 
pages/objects (see “Common Configurations” ).

Loads	control	(system	with	F421	control	unit)

Configuration:
	• Description
Enter the description of the object (15 characters max.).
	• Priority
Enter the priority associated to the selected load.
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This section is used to define the objects found in the “Temperature control“ web 
page, which is used to manage the temperature control system. 

	– System	99	zones
This window can be used to insert a 99 zone control unit and customise its 
description.
Add the pages/objects (see “Common Configurations” ).

Temperature	control

ZONES
For each of the 99 zones the configuration parameters must be entered.
Add the pages/objects (see “Common Configurations” ).
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Configuration:
	• Description
Enter the description of the object (15 characters max.).
	• Address
Enter the zone address.
	• Type
Enter the type of function (heating, cooling, or both).
	• Fan‑coil
Specify if the type of device is a Fan-coil.

PROGRAMS
For each of the two types of operations (winter/summer) up to 3 programs can be 
enabled, and their description customised.
Add the pages/objects (see “Common Configurations” ).

Configuration:
	• Description
Enter the description of the object (15 characters max.).
	• Type
Enter the type of operation (summer/winter).
	• Number
Enter the program number.
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SCENARIOS
For each of the two types of operations (winter/summer) up to 16 scenarios can 
be enabled, and their description customised.
Add the pages/objects (see “Common Configurations” ).

Configuration:
	• Object	description
Enter the description of the object (15 characters max.).
	• Type
Enter the type of operation (summer/winter).
	• Number
Enter the scenario number.

	– System	4	zones
This window  can be used to insert a 4 zone control unit and customise its description.
Add the pages/objects (see “Common Configurations” ).

For the configuration of the “Zones” and “Programs” items see “System 99 zones”. 
For this type of control unit the scenario item is not included.
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	– Uncontrolled	zones
This window  can be used to configure the zones not controlled by the control unit.
Add the pages/objects (see “Common Configurations” ).

Configuration:
	• Description
Enter the description of the object (15 characters max.).
	• Address
Enter the zone address.

	– External	probes
This window  can be used to configure external radio probes.
Add the pages/objects (see “Common Configurations” ).

Configuration:
	• Description
Enter the description of the object (15 characters max.).
	• Address
Enter the address of the external probe.
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	– Basic	climate	control
This section can be used to configure the AC units and the groups of commands 
that will be available in the temperature control/air conditioning function page. 
In the case of basic climate control, the management function is performed only 
through the 20 commands saved on the 3456 interface.

AC UNITS
This window can be used to configured the AC unit.
Add the pages/objects (see “Common Configurations” ).

Configuration:
	• Description
Enter the description of the object (15 characters max.).
	• Address
Enter the 3456 interface address (see "Common Configurations” ).
	• Show	Off	command
Select “Yes” to display the OFF command in the web page
	• Number	of	OFF	command
Enter the number of the command configured as OFF on the 3456 interface.
	• Probe	enabled
Enable/disable the presence of a slave temperature probe. 
	• Probe	address
Click to enter the address of the slave probe.
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Configuration:
	• Description
Enter the description of the object (15 characters max.).
	• Address
Enter the address of the command on the 3456 interface.

GROUP OF COMMANDS
For the management of climate control it is possible to create a group of commands, 
selected among the ones saved on the 3456 interface.
Add the pages/objects (see “Common Configurations” ).

 - FAVOURITE COMMANDS
Enter the favourite commands selected among the 20 available on the 3456 
interface for the management of the AC unit.
Add the pages/objects (see “Common Configurations” ).
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Configuration:
	• Description
Enter the description of the object (15 characters max.).
	• Associated	commands
Click to select the commands making up the group.

1.	Enter the 3456 interface address (see "Common Configurations” ).
2.	Enter the command number.
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	– Advanced	Air	Conditioning
This section can be used to configure the AC unit objects and the groups of 
commands that will be available in the temperature control/air conditioning 
function page in advanced mode.
The management is performed directly as if the remote control of the splitter was 
used or in any case using the favourite commands to be created in the appropriate 
sections. 

AC UNITS
Enter the AC units to configure.
Add the pages/objects (see “Common Configurations” ).

This window can be used to configure the parameters of the AC unit.
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Configuration:
	• Address
Click to enter the 3456 interface address.

	• Probe	enabled
Enable/disable the presence of a slave temperature probe.
	• Probe	address
Click to enter the address of the slave probe.

	• Show	Off	command
Enable/disable the Off command.
	• Minimum	temperature
	• Maximum	temperature
Enter the maximum temperature that can be handled by the splitter.
	• Step
Enter the desired increase step, choosing between 0,5 °C e 1 °C.
	• For	 the	 Automatic,	 Cooling,	 Heating,	 Dry,	 Fan,	 Fan	 speed	 presence,	
Automatic,	High,	Medium,	Low,	Silent,	Swing	presence,	ON,	OFF	modes:
Select Yes to make the function available in the corresponding page.
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 - FAVOURITE COMMANDS
Enter the favourite commands for the management of the AC unit.
Add the pages/objects (see “Common Configurations” ).

Configuration:
	• Description
Enter the description of the object (15 characters max.).
	• Configuration
Click to set the parameters that will be performed by the command configured.

	• Temperature
Select the temperature to set.
	• Mode
Select the operating mode.
	• Speed
Select the fan speed.
	• Fan	Swing
Enable the swing.
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GROUP OF COMMANDS
For the management of climate control it is possible to create a group of commands 
that will be performed at the same time.
Add the pages/objects (see “Common Configurations” ).

Configuration:
	• Description
Enter a description of the group of commands (15 characters max.).
	• Associated	commands
Click to select the commands making up the group.

1

1.	Enter the commands.
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2

2.	Click to enter the 3456 interface address.

3.	Configure the command.
Select the temperature to set, the operating mode, the fan speed and the 
enabling of the swing. 
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	– Supervision	system
This section can be used to configure the system supervision functions that will be 
available in the “Supervision” web page.

STOP & GO
This section can be used to configure the Stop & Go resetting modules for the 
control of the automatic earth leakage relay reset function, and other functions.
Add the pages/objects (see “Common Configurations” ).

Configuration:
	• Description
Enter the description of the object (15 characters max.).
	• Type
Select the type of resetting module, either Normal, Plus, or Btest.
	• Address
Enter the Stop & Go address.

LOAD DIAGNOSTIC
This section can be used to set which loads can be subjected to diagnostic, to 
control their operating status (advanced actuators only). 
Add the pages/objects (see “Common Configurations” ).

This section is used to define the objects found in the “Energy Management“ web 
page, where it is possible to monitor the system, display the energy data, and 
manage the loads.

Energy	Management
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	– Energy	data
This section can be used to configure the parameters that enable displaying the data 
(consumption/production) measured on the system in the "Energy data" web page.
Several measurement parameters are available:

Configuration:
	• Description
Enter the description of the load (15 characters max.).
	• Address
Enter the address of the actuator.

Meter type Description Unit

Electricity
It display the electricity consumed or produced by the system. Kw

Water It measures the water consumed.
m3

Connect the meter to a water meter with impulse output.

Gas It displays gas consumption.
m3

Connect the interface to a gas meter with impulse output.

DHW
It measures the hot water consumed. 

KwConnect to a hot water meter or to the corresponding impulse 
output of a heat measurement control unit that can be found 
in the apartment user modules (in case of central heating).

Heating/
Cooling

It displays the calories/frigories measured on the heating/
cooling system.

Kw

Connect to a meter with heat impulse output (KWh).
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Add the pages/objects (see “Common Configurations” ).

The configuration is the same for all meters.

Configuration:
	• Description
Enter the description of the object (15 characters max.).
	• Address
Enter the meter address
	• Unit	of	measure
Select the unit of measure used to display the consumption.
	• Economic	evaluation
Enable/disable the economic evaluation.
Enable this function to create a row in the “Tariff setup” where the user can set 
the tariff to apply to the specific consumption.

The economic evaluation is performed based on the tariff indicated in the  
“Tariff setting” section.

	• Type
Define if the meter is a consumption or a production meter.
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	– Load	management	with	control	unit
This section can be used to manage the new Load Management system, to display 
the status of a load, force the re-activation based on priorities, set the forcing 
time, and display the consumption.

Configuration:
	• Description
Enter the description of the load (15 characters max.).
	• Priority
Select the load priority
	• Mode
Set if this is a basic or an advanced actuator. In the second case, the instantaneous 
consumption and 2 meters can be displayed.
	• Economic	evaluation
Enable/disable the economic evaluation (Advanced mode only).
The tariff is set in the “Tariff setting” section.
	• Type
Define if the load is a consumption or a production load.

	– Load	management	without	control	unit
The configurations for this mode are the same as the “With Control unit” mode, 
with the exception of the “Mode” field, which is automatically set to “Advanced”.
The object of this function is to display the consumptions of the loads, even 
without control/forcing.

Add the pages/objects (see “Common Configurations” ).
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This section can be used to configure the zones and the auxiliary channels 
displayed in the "Alarms" web page.

	– Zones
In this window  you can customise the descriptions of the zones of the Burglar-
alarm system.
The descriptions entered will appear in the messages that the device sends to 
the Web page every time there is a Burglar-alarm or Technical Alarm event in the 
system. 
Add the pages/objects (see “Common Configurations” ).

Configuration:
	• Description
Enter the description of the zone (15 characters max.).
	• Number
Enter the zone number
	• Camera	Presence
Enable the Camera Presence so that the e-mail for the notification of a zone 
burglar alarm sent by the device will include a compressed file (.zip) containing 
the images (.jpg) recorded by the camera. 
Example: If the sensor the alarm comes from is configured with Z=2 (zone 2), 
this is capable of automatically activating the camera (with the exception of any 
Entrance Panel cameras) configured with P = 2.

	 Burglar‑alarm
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	– Auxiliary	alarms
The same procedure used for the zones may be used to customise the descriptions 
of the 9 auxiliary channels used for the notification of technical alarms (for 
example it is possible to enable Auxiliary	channel	1 and assign the description 
“gas	leak”).

Configuration:
	• Enabling
Enabling/disabling the auxiliary channel. 
	• Description
Enter the description of the auxiliary channel (15 characters max.).
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Configuration:
	• Description
Enter the description of the camera (15 characters max.).
	• Address
Click to select the camera address (0 to 99).

This section can be used to define the objects found in the “CCTV” web page, 
where it is possible to manage the cameras found in the system. 
Add the pages/objects (see “Common Configurations” ).

	• Brightness	/	Contrast	/	Colour	/	Quality
Select the picture setting levels (from 0% to 100%).
	• Staicase	light
Enable the presence of the staircase light actuator.
	• Lock
Enable the presence of the door lock release.

Cameras
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This screen can be used to enable and configure the video door entry system 
answering system found in the corresponding web page. 

Configuration:
	• Answering	system	enabling
Enable the video answering system function.
	• Auxiliary	activation	channel
By enabling the activation of the auxiliary channel, it is possible to use a 
command to enable/disable the answering system, and insert a luminous signal 
for the activation status. 
	• Auxiliary	activation	channel
Select the auxiliary activation Channel used by the control device, for local 
enabling/disabling of the “Video	door	entry	Answering	system”.
	• Address
Click to enter the SCS address of the answering system status notification 
actuator (see “Common Configurations” ).
	• Message
Select one of the pre-recorded files (.wav) or record a new message.
Use the pushbuttons in the window to:

Answering	machine	‑	settings

A) Listen to the selected message
B) Stop the playing or recording 
     of the message

C) Cancel the selected file
D) Record a new message
E) Store a new message
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	• Number	of	photos
Select the number of pictures that the video door entry entrance panel camera 
will send to the device. You can choose from 1 to 16 photographs.
If the “e‑mail	 service” option is active, the pictures will reach the user as 
attachments to an e-mail message.
	• e‑mail	service
Enable this service to receive the e-mail message containing the recorded 
pictures, selecting the Ethernet transmission method.

	– Entrance	panels
This window can be used to enable up to 10 entrance panels of the video door 
entry system, to which the answering system will answer, if enabled. 
Add the pages/objects (see “Common Configurations” ).

Configuration:
	• Address
Configure the entrance panel address (0 – 95)

	• Camera	presence
Activate the camera presence.
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4.4.2	Notification	via	e‑mail
This window can be used to enable e-mail forwarding of alarms. 

Ethernet	e‑mail	enabling

Configuration:
	• Enabling
Enable/Disable the notification via Ethernet e-mail.
	• Account	name
Enter the name of the account.
	• Addressee’s	e‑mail
Enter the electronic mail address to which the e-mail will be sent.
	• Sender’s	e‑mail
Enter the sender’s e-mail address.
	• SMTP	server	address
Enter the IP address of the mail server in numerical format or in text format 
(contact the network administration to obtain this information).
	• Authentication	type,	User,	Password,	Port,	Tls,	Start	tls,	Tls	certificate
Enter the correct parameters of your own e-mail account.
For Tls enter a certified file.
	• Temperature	control	diagnostic
By enabling this function, when there is a fault in the Temperature control 
system a message will be sent to the e-mail address provided.
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4.4.3	MyHome	portal
By enabling the “Portal Enabling” item, this window can be used to enter the 
Gateway ID of the My Home Web Portal, and complete the configuration using the 
“Connection parameters”, and the “Auxiliary events notification” sections.

Configuration:
	• Portal	enabling	mode
Enable/Disable the connection to the My Home Portal.
	• ID	gateway
Insert the portal system ID code. 
	• Connection	type
Select the type of connection:
‑	Fixed	IP: if a fixed address is available
‑	Dynamic	IP: if the fixed IP address is not available; it will be possible to set 
the My Home portal access ports on the router
‑	Active	 Web	 Server	 connection	 (WAC):	 In private networks where the 
system cannot be reached directly be the Internet (e.g.: Fastweb), or the 
router cannot be configured for using the My Home Web services, it will be 
necessary to set the WAC connection mode (Active Connection of the Web 
Server) in the configuration of the Web Server and the system on the Portal.

Connection	parameters
The data in this section have been pre-filled in by default. Errors in changing the 
information present may compromise the operation of the services.  
It is however recommended that the information match the data provided by your 
service provider. 
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Auxiliary	events	notification
This section can be used to select which of the events generated on the auxiliary 
channels by the Automation and Burglar Alarm devices must be sent to the My 
Home Web portal. 
Add the pages/objects (see “Common Configurations” ).

Configuration:
	• Number
Enter the number of the channel used to send the information to the portal. 
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5.	Tariff	setting	
On completion of the project configuration, click the forward arrow on the bottom 
left to set the tariffs that will be applied to the consumptions set in the “Energy 
management” and “Load management” sections.

A)	Select the currency to apply.
B)	Enter the tariff.
C)	Enter the number of decimals to display.





BTicino	SpA
Via Messina, 38
20154 Milano - Italy
www.bticino.com

BTicino SpA reserves at any time the right to modify the contents of this booklet and to communicate, 
in any form and modality, the changes brought to the same.
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